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Introduction

•
•
•
•
•

Included in Final Cut Pro 4
Final Cut Pro 4 for editing
Cinema Tools for film
LiveType for titling
Soundtrack for music
Compressor for encoding

Apple’s Emmy Award–winning Final Cut Pro is one of the most sophisticated and scalable digital nonlinear editing systems available. Whether your work is film or broadcast,
HD or SD, online or offline, Final Cut Pro 4 has the creative tools, professional features,
and flexibility to meet the grueling demands of the post-production industry.
Its feature-rich toolset, new customization capabilities, and enhanced trimming tools
have been designed for professional editors. RT Extreme, an enhanced multistream,
real-time effects architecture, lets editors choose between preview quality (for maximum
simultaneous streams and effects) and full-resolution real-time output (for maximum
image quality). Multichannel output and multitrack audio mixing from a new mixing
console, real-time Mac OS X Audio Units filters, and precise fader automation raise the
bar for audio editing capabilities in a professional nonlinear editing application.
Final Cut Pro 4 also includes tools that give video editors new ways to explore
their creativity and produce high-quality, professional results: LiveType, a resolutionindependent title generator; and Soundtrack, an innovative music composition tool
that makes creating custom music scores incredibly easy. Compressor, a new batch
encoding application that delivers pristine-quality QuickTime, MPEG-2, and MPEG-4
video, is included with Final Cut Pro as well. Its new, industry-leading MPEG-2 encoder
delivers the highest-quality output, rivaling that of more expensive hardware-based
solutions. Cinema Tools is now included for native 24-fps and film support.
Uncompromising image quality, broad format support, and a comprehensive suite of
corrective finishing tools make Final Cut Pro 4 appropriate for SD and HD broadcast
applications. Broadcast-quality codecs let online editors work with 8- and 10-bit uncompressed YUV 4:2:2 SD and HD video for finishing. New High Dynamic Range (HDR)
imaging goes beyond 8- and 10-bit video, compositing elements using a full 32 bits
per channel (floating point) to process effects with unprecedented clarity and precision.
With built-in support for Panasonic’s DVCPRO50 format, Final Cut Pro has the power to
deliver professional YUV 4:2:2, broadcast-quality images from the field or edit bay over
a single FireWire connection.
Final Cut Pro 4 uses a new XML standards-based composition and metadata format
that bridges the gap between disparate edit systems, asset management databases,
and customized post-production workflows. The XML interchange format gives Final
Cut Pro 4 the flexibility to fit into any production pipeline. A new plug-in API, enhanced
EDL support, and FXScript make it the most extensible nonlinear editor available.
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Final Cut Pro 4 at a Glance

One of the most sophisticated and scalable solutions available, Final Cut Pro is
quickly becoming the tool of choice for a new generation of professional film and
video editors. Whether your work is film or broadcast, HD or SD, online or offline,
Final Cut Pro can meet the demands of tight production schedules.

Creative Tools for Professional Editors
Final Cut Pro 4 has the sophisticated editing, compositing, effects, and audio tools
that professional editors need to create today’s most demanding programs.
• RT Extreme. RT Extreme leverages the strengths of Mac OS X and the PowerPC
processor to support a scalable number of video streams and real-time effects with
output to a broadcast monitor. The number of available video streams and real-time
effects increases as processor speeds increase. New real-time modes allow editors
to choose full-resolution output for finishing, or real-time preview for maximum
simultaneous streams.
• Customization. Editors can select from more than 600 tools and commands to
customize their systems, including the keyboard (with support for multiple modifier
keys) and user interface buttons. The Browser, window arrangements, and Timeline
track layouts can also be customized for maximum flexibility. All custom settings can
be saved and used on any other Final Cut Pro 4 system.
• Audio. The new onscreen multitrack mixer and multichannel audio output raise the
bar for NLE-based audio. Real-time fader automation, keyframe thinning, and support
for many Mac OS X Audio Units (with live parameter adjustments) provide professional
audio tools within the Final Cut Pro interface.
• Editing and trimming controls. Editors can now perform asymmetric and dynamic
(JKL) trims, use merged clips, gang playback between windows, detect duplicate
frames, and much more. Featuring an improved user interface, the enhanced Timeline
supports variable track heights, keyframe graphs, and new Auto Select tools.
• Time remapping. Using keyframes, editors can speed up, slow down, reverse, or ramp
playback speed over time without rendering. Frame blending is used to generate the
highest-quality output possible. Time-remapping operations can be performed
graphically in the Timeline.
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Professional Output and Scalability for Broadcast Applications
Final Cut Pro 4 is a powerful solution for creating high-quality programming in a
broad range of formats, frame rates, and resolutions.
• Resolution independence. Built on a resolution-independent architecture that allows
it to scale easily from SD to HD, Final Cut Pro 4 supports 23.976, true 24, 25, 29.97, and
30 frames per second (fps) editing.
• Broadcast-quality codecs. Final Cut Pro 4 includes fully uncompressed 8- and 10-bit
4:2:2 YUV codecs for both SD and HD video. Native support for Panasonic’s DVCPRO50
format allows editors to work at low data rates with broadcast-quality 50-Mbps 4:2:2
YUV video over FireWire.
• Advanced render engine. The Final Cut Pro 4 render engine is among the industry’s
most advanced, with support for 8-, 10- and 32-bit (High Dynamic Range) rendering.
HDR imaging can be used for many operations to yield maximum quality. Composites
and effects rendered in Final Cut Pro are suitable for SD and HD mastering as well as
film output.
• Comprehensive color correction tools. Primary and secondary YUV color correction
tools, image control filters, waveforms and scopes, and range-checking tools can be
used in conjunction with the new Frame Viewer for comparing multiple shots.
• Cinema Tools for managing film projects. Now included with Final Cut Pro 4, Cinema
Tools supports several film formats, keycodes, key numbers, ink numbers, and a variety
of output lists, including change lists. Advanced pull-down tools handle 2:3 and 2:3:3:2
telecine operations.
• Compressor. This new batch encoding tool prepares media to be distributed on
DVD or streamed over the Internet. Compressor supports various QuickTime formats,
including MPEG-4 and a new MPEG-2 encoder that supports two-pass VBR encoding
and advanced motion estimation.
• Media management. Enhanced media management capabilities include intelligent
capturing of video across timecode breaks and gaps in tape; project and sequence
consolidation and transcoding; a new multi-item properties window with difference
highlighting; the ability to create master clips and affiliate clips, match frame to master
clip, match frame with “reveal in Browser,” work with merged clips, and edit nested
sequences with automatic unnesting; advanced telecine operations; and support for
the Panasonic DVX100 and SDX900 24-fps DV cameras.

Extensible and Flexible for Facilitywide Integration
Its open, standards-based architecture allows Final Cut Pro 4 to fit into virtually any
production pipeline.
• XML interchange format. Final Cut Pro 4 uses a new XML interchange format for
exchanging project, bin, sequence, clip, and media information with other nonlinear
editing systems, asset management systems, and broadcast servers. This new format
describes every aspect of a program, from edits and transitions to effects, color correction settings, and keyframe data. Media-attached metadata is preserved throughout
the entire Final Cut Pro workflow. A new plug-in API and complete developer documentation will be available for developers to build custom import/export components
that take advantage of the XML interchange format. The XML interchange format will
be available as a public beta for customers to download in summer 2003.
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• I/O framework. A new I/O framework allows developers to create fully uncompressed
8- and 10-bit audio and video devices using the Apple-invented, industry-standard
FireWire (IEEE 1394) technology. Coupled with the new uncompressed 8- and 10-bit
SD codecs in Final Cut Pro 4, the I/O framework makes adding professional video I/O
components as simple as plugging in a single FireWire cable.
• Improved EDLs. Final Cut Pro 4 has improved EDL functionality and can generate
accurate lists that include speed changes and still-frame information for legacy linear
and nonlinear systems.
• QuickTime. With support for dozens of media types, QuickTime provides Final Cut
Pro with the infrastructure necessary to share files with other applications, preserve
metadata, and capture video with sample-accurate A/V synchronization.
• Plug-ins. Final Cut Pro 4 supports several plug-in formats for adding effects and
extending functionality. FXScript is the native visual effects scripting language built
into Final Cut Pro. Adobe After Effects plug-ins are also supported (must be compatible with version 3 of the After Effects plug-in specification). Mac OS X Audio
Units plug-ins are supported for audio effects and filters.
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Final Cut Pro 4 in the
Professional Markets

Features for broadcast
• Scalability (DV, SD, HD)
• RT Extreme for a virtually unlimited number
of video streams and effects
• Corrective finishing tools, YUV color
correctors, scopes, and image controls
• Interoperability (XML interchange)
• Broadcast-quality codecs (uncompressed
and DVCPRO50 for 4:2:2 video)
• 8-, 10-, and 32-bit rendering

•
•
•
•
•
•

Features for film and television production
Cinema Tools now included for native 24-fps
HD and film support
Asymmetric and dynamic trimming tools for
professional editors
Customizable keyboard and user interface
Edit using merged clips and master clips
Full offline and online workflows, simplified
with an advanced Media Manager
Professional audio mixing and output

Features for commercial post
• Editing, compositing, effects, and advanced
audio all within the Final Cut Pro interface
• RT Extreme for a virtually unlimited number
of video streams and effects
• Cost-effective, broadcast-quality uncompressed editing and finishing in SD and HD
• LiveType for advanced animated and
motion titles
• Soundtrack for custom, royalty-free music
composition

Professional Broadcast News and Promotions
Under pressure from shrinking budgets and tighter deadlines, many broadcasters
have discovered that Final Cut Pro provides a cost-effective and flexible solution for
their increasingly complex production requirements. In today’s broadcast studios,
where single-tasking equipment is no longer an affordable luxury, the Macintosh
platform is a high-performance, multipurpose solution that can be used for editing,
effects, graphics, and general productivity applications. Mac OS X, Apple’s Macintosh
operating system, is a fully UNIX-based system that is compatible with and can be
easily integrated into any enterprise network.
Regardless of your acquisition standard or your signal infrastructure, Final Cut Pro 4
can play a central role in your production workflow. From the field to the newsroom
and studios cutting local-interest shows, station promos, or specialty segments, Final
Cut Pro 4 lets you get your project in on time by providing integration, interoperability, stability, and Apple’s legendary ease of use.

Independent Editors and Production Companies
Desktop-based post-production, unthinkable a short time ago, has become the
norm for film and television projects. With its ability to scale from offline to DV,
SD, HD, and film, Final Cut Pro is quickly becoming the new tool of choice for many
independent editors and production companies. Engineered for maximum flexibility
and ease of use, Final Cut Pro has been used for both offline and online tasks for
everything from high-profile episodic television series and sitcoms to major studiobased motion pictures.

Commercial Post-Production
Facilities that focus primarily on short-format televised content like commercials,
music videos, and infomercials have specialized production needs and even tighter
deadlines than other types of programming. These productions require the flexibility
to use multipurpose workstations for editing, effects, animation, titling, music, and
audio. Final Cut Pro 4 has the ability to adapt to virtually any professional format and
frame rate in both offline and online capacities, making it appropriate for facilities
that need to work across the entire production spectrum.
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Features for corporate users
• RT Extreme for a virtually unlimited number
of video streams and effects
• Intuitive, easy-to-use interface
• Scalable solution that can grow as needed
• LiveType and Soundtrack for professional
titles and music
• Advanced output and encoding options
(video, web, DVD, CD-ROM)

Corporate, Industrial, and Institutional Videographers
Final Cut Pro 4 is an incredibly robust and cost-effective solution for corporate and
institutional professionals who need to create compelling, high-quality content on
an extremely tight budget. Whether it’s a corporate training video, a college football
game, or a government crime scene investigation, Final Cut Pro 4 gives editors of all
levels access to the same powerful tools used by production professionals.

Event Videographers
Features for event videographers
• Cost-effective, powerful, and comprehensive
• LiveType and Soundtrack for professional
titles and music
• RT Extreme for a virtually unlimited number
of video streams and effects
• Intuitive, easy-to-use interface
• 12GB of music and titling content included
• Advanced output and encoding options
(video, web, DVD, CD-ROM)

Videography for weddings, corporate engagements, and religious events is highly
competitive, and everything in the studio needs to pull its own weight. Maximum
productivity and high production values are required for creating videos, DVDs, web
movies, slideshows, and CD-ROMs. Spending vast amounts of money on music, titling
software, and libraries of content is not an option. Whether you are a professional
videographer or a budding filmmaker, Final Cut Pro 4 provides all the tools you need
to get the job done.
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Workspace Overview

•
•
•
•
•
•
•
•
•

Key features
User interface
Flexibility and customization
Keyboard and button bars
Windows
Timeline
Browser
Viewer and Canvas
Trim Edit window
Tool Bench windows

User Interface
Professional editors have been switching to Final Cut Pro in increasing numbers, due
in large part to its superior user interface and streamlined, nonmodal workflow. The
user interface includes four primary windows: the Browser, the Timeline, the Viewer
(source monitor), and the Canvas (record monitor). There is also a small tool palette
and a pair of VU meters showing audio levels.
Browser

Viewer

Canvas

Tool palette
VU meters

Timeline

Final Cut Pro 4 is nonmodal, creating a very fluid environment. The editor can
work quickly and seamlessly, performing editing and effects operations without
time-consuming mode or toolset changes.

Flexibility and Customization
Final Cut Pro 4 is extremely flexible, allowing editors to work in a comfortable and
intuitive manner. Wherever possible, the user interface is context sensitive and
provides multiple ways for accomplishing a given task: by mouse (drag and drop),
with a button in the interface, through a menu command, with contextual menus
(accessed via Control-clicking or right-clicking), or through keyboard shortcuts.
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To help professional editors ease the transition from legacy NLEs to Final Cut Pro,
many aspects of the program are fully customizable. Custom settings can be imported
or exported and loaded on any Final Cut Pro 4 system. All custom settings are stored
in the user’s Preferences folder for easy access. The following elements can be
customized in Final Cut Pro 4:
•
•
•
•
•

Keyboard
Button bars
Browser column order, width, and layout
Window arrangements
Timeline track sizes (independently, by type, or for all)

Keyboard and Button Bars
The Final Cut Pro 4 keyboard layout is fully customizable. Over 600 commands and
functions can be mapped to any keyboard shortcut. Keyboard customization provides
the following benefits:
• Significantly reduces the learning curve for editors who are used to the keyboard
assignments on other systems.
• Facilitates customized, task-based workflows through reassignment of commands.
• Improves speed for left-handed users by allowing them to place commands where
they are most convenient.
To open the Custom Keyboard Layout window, select Keyboard Layout from the
Tools menu.
Modifier key combinations

Search field

Command list
organized by menu
and function

Lock button

Commands can be dragged onto the key they are to be assigned. Alternatively,
editors can select a command and type the desired key combination. Final Cut Pro 4
allows the creation of an unlimited number of custom keyboard layouts; up to five
layouts can be assigned to shortcuts for easy switching while editing. The keyboard
customization options in Final Cut Pro 4 are unique because:
• The fast, powerful search tool makes it easy to find commands.
• Onscreen tool tips are automatically updated with the new keyboard shortcuts.
• The command list is organized by both menu and function.
• The keyboard can be customized with multiple modifier keys.
• Final Cut Pro 4 automatically detects the proper layout based on the keyboard
attached to your system (extended keyboard, PowerBook keyboard, international
keyboard).
• Keyboard layouts can be saved as text files for printing a customized shortcut list.
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In addition to keyboard customization, any of the 600-plus commands and functions
can be added as buttons directly to the user interface. These buttons can be placed
in button bars in the top area of the Final Cut Pro windows. Commands can be
dragged to the button bars from the Custom Keyboard Layout window or from the
Button List window (also available in the Tools menu). You can then click any of the
shortcut buttons in the button bar to perform commands, instead of entering key
combinations or using menus.
Once buttons have been added to the windows, they can be reordered by simply
dragging them. Buttons can be removed by dragging them off the button bar.
Custom colors and spacers can be added by Control-clicking (or right-clicking with
a multibutton mouse) and selecting the desired option from the context-sensitive
pop-up menus. This flexibility lets editors create organized groupings of buttons
that can be spaced and color coded for easier navigation.
Custom buttons
Add custom colors

Add spacers

Windows
Managing windows in Final Cut Pro 4 is easy and flexible, so you can tailor the workspace to suit your needs.
Arrangements
Final Cut Pro 4 supports single and multiple monitor window arrangements. All
custom window arrangements can be saved and loaded on any Final Cut Pro system.
New to version 4, custom window arrangements can be saved in absolute positions
or relative positions (so they resize accordingly if the screen resolution changes).
Several task-based window arrangements are included. If multiple monitors are
detected, additional window arrangements appear automatically in the Window
menu > Arrange. An unlimited number of custom window arrangements can be
saved; up to five can be assigned to shortcuts for easy switching while editing.
Tabbed windows
All the tabbed windows in Final Cut Pro can be dragged out of or into each other to
create independent or consolidated windows as desired. For example, the Effects tab
in the Browser can be dragged out to create a window of its own. Dragging it back
to the Browser consolidates the two windows.
One-click dynamic resizing
Resizing windows is greatly enhanced in Final Cut Pro 4. Dragging the border between
windows allows the entire user interface to be dynamically resized.
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Timeline
Final Cut Pro 4 includes a redesigned Timeline with an improved user interface and
additional convenience and editing features. As with previous versions, a Final Cut
Pro sequence can contain up to 99 audio and 99 video tracks. Nesting of sequences
allows for a virtually unlimited number of tracks.
Track lock
Auto Select

Program timecode/frame count

Snap and link

RT/Video
playback menu
Track visibility
Custom track
heights

Mute/Solo
Audio controls,
toggle clip keyframes,
overlays, and track
height controls
Zoom controls

Through edit indicators
(show adjacent frames)

Source/Destination

The new Timeline includes the following enhanced controls and features:
• Mute and solo buttons provide additional audio control.
• Track visibility indicators let you turn tracks on and off.
• Source and destination columns allow you to target edits to specific tracks.
• Track locks let you lock the contents of a track.
• Auto Select buttons determine which tracks certain edit operations will affect.
• RT pop-up menu provides both RT Extreme and video playback quality controls.
• Program timecode can now be viewed as drop frame, non-drop frame, or sequential
frames.
• Snap and link buttons are easier to see and have moved to the button bar.
• Enhanced zoom controls now zoom to the location of the playhead.
• Controls at the bottom left toggle audio controls, clip keyframes, clip overlays, and
track heights.
• Duplicate frame use can be detected and highlighted in the Timeline.
• Video and audio keyframe editor and speed indicators are now available in the
Timeline.
The track height controls near the bottom left of the Timeline include a submenu
of additional options for saving and restoring custom track layouts, adjusting track
heights, and turning on filmstrip view, audio waveforms, through edits (adjacent edits),
and duplicate frames.
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Nested sequences
Final Cut Pro 4 supports 99 audio and 99 video tracks. Sequences can be nested inside
one another to create a virtually unlimited number of tracks. New to Final Cut Pro 4,
sequences can be edited inside other sequences as collapsed nests (one track) or as
fully expanded sequences (multiple tracks). Nesting sequences is useful for simplifying
complex, multilayered projects; for breaking a project into different edited scenes
(or acts); and for applying effects, filters, and transitions to an entire show at once
(a widescreen matte or a timecode generator, for example).
Source and destination
When you open a clip in the Viewer, the number of source controls in the Timeline
changes to correspond to the number of video and audio items that make up the clip.
For example, if you load a clip in the Viewer that contains one video and four audio
items, one video and four audio source controls appear in the source column of the
Timeline patch panel.
Auto Select controls
The Auto Select controls can be used to target certain edit operations to specific
tracks (a lift edit, for example). If In and Out points are set in the Timeline, only the
Auto Select–enabled tracks are highlighted for editing.
Highlighted tracks with Auto Select “on”
can be edited (A1, A2, V1, V4)

Auto Select
“off” on V2, V3

Show duplicate frames
Final Cut Pro 4 can mark frames used more than once in an edited sequence. Colored
bars appear at the bottom of the clip’s video in the Timeline if it contains frames
that have been used more than once. You can adjust parameters (like handles and
thresholds, for film editors) that determine the behavior of duplicate-frame indicators
by opening the preferences in the Final Cut Pro menu > User Preferences > General.
Control-clicking (or right-clicking) a duplicate-frame warning shows other locations
of the duplicate frames in the sequence. Selecting another location from the pop-up
menu moves the playhead to the repeated frames at the timecode indicated.
Duplicate-frame indicators

Selecting the duplicate frame from the list moves the
playhead to the location of the repeated frames
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Video and audio keyframe editor and speed indicators
The keyframe editor now allows display and editing of keyframe graphs for motion
effects and filter parameters directly in the Timeline. Keyframe graphs can be toggled
on and off using the buttons at the bottom left of the Timeline.
Timeline graphs are identical to those in the keyframe graph area of the Motion and
Filters tabs in the Viewer. The keyframe graph area is resizable independent of track
height. Just below the keyframe graph area are speed indicators that show the speed
of clips in the sequence using tick marks. The spacing of these marks indicates the
speed and playback direction of your clips (black is forward, red is reverse). The clip
shown below includes variable speed changes made with the Time Remap tool.

Keyframe graphs
with Bezier control

Speed ticks
(red is reverse)

Browser
The Browser, like all other windows in Final Cut Pro 4, contains multiple tabs. Final
Cut Pro 4 lets editors keep multiple projects with multiple sequences open at the
same time. The Browser contains a tab for each open project. An Effects tab in the
Browser lists all of the filters, effects, and transitions in Final Cut Pro.
Tabs for multiple projects
Tab for open bins

Columns can be resized
and reordered

Bins and
media in
list view

Contextual menus for showing or
hiding additional data

In addition to tabs for projects and effects, individual bins can be opened into their
own tabs in the Browser. The Browser has both list and icon views.
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The Browser has 50 columns (51 including the Name column) that provide the
following information:
Duration

In

Out

Media Start

Media End

Tracks

Good

Log Note

Label

Label 2

Audio

Frame Size

Video Rate

Compressor

Data Rate

Audio Rate

Audio Format

Alpha

Reverse Alpha

Composite

Pixel Aspect

Anamorphic

Field Dominance

Description

Scene

Shot/Take

Master Comment 1

Master Comment 2

Master Comment 3

Master Comment 4

Reel

Master Clip

Offline

Last Modified

Film Safe

Aux 1 Reel

Aux 2 Reel

Aux Timecode 1

Aux Timecode 2

Type

Timecode

Speed

Frame Blending

Comment A

Comment B

Length

Capture

Source

Size

Thumbnail

Finding things
Searching, sorting, and sifting through large amounts of media is simple using the
powerful built-in search tool. When the Browser is active, the Find command is
available in the Edit menu.
Search the current project,
effects, or all open projects
Search through all media, used
media, or unused media
Add or remove
up to 8 search
parameters

Perform powerful searches from
any of the 51 Browser columns

Use Boolean search criteria

Viewer and Canvas
The Viewer and the Canvas (source and record monitors) include a collection of similar
controls. Both have deck/transport controls, as well as numerous buttons for marking
clips. Pop-up menus along the top of each window are used for setting zoom level,
ganged playback options, and view parameters.
Clip attribute tabs
Viewer

Source timecode Open sequence tabs
Canvas
Program
timecode

Duration

Ganging
Image pop-up
with menu open

Zoom

Jog, playback,
and shuttle

Scrub area

Mark In/Out

Generators

Recent clips
Matchframe, mark, clip/sequence,
add keyframe, add marker buttons

Insert, overwrite,
replace, fit-to-fill,
and superimpose

Product Overview
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Identifying the contents of the Canvas or the Viewer is simple. The title bar at the top
of each window shows where clips or sequences have come from. In addition to the
text-based indicators in the Viewer and Canvas title bars, there are visual cues to help
the editor. For example, in the Viewer, clips that show film-perfs in the scrub area have
been loaded from the sequence. Clips that do not have film-perfs in the scrub area
have been loaded from the Browser. This distinction is important when deciding to
apply effects and filters to clips in the sequence or to source media in the Browser.
It is also useful when working with the matchframe feature.

Trim Edit Window

Source loaded from sequence (perfs)

Trimming operations can be done directly in the Timeline. For editors who are more
comfortable working in a dedicated trimming interface, there is also a Trim Edit
window. The Trim Edit window can be opened by double-clicking any edit point in a
sequence. New to version 4, dynamic (JKL) trimming is now supported, streamlining
the process of trimming to picture or dialog.
Timecode/Duration
information

Playback controls
Multiframe trim buttons

Dynamic (JKL) trimming

Tool Bench Windows
Tool Bench windows can be opened and used for the following tools: Audio Mixer,
Video Scopes, Voice Over, QuickView, and Frame Viewer. Multiple Tool Bench windows
can be opened simultaneously for a completely customized workflow.
Viewer with Color Corrector

Tool Bench

Product Overview
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Input

•
•
•
•
•
•

Key features
Supported formats
Easy Setups
OfflineRT
DV, DVCAM, DVCPRO, and DVCPRO50
Broadcast-quality codecs
Log and capture

Final Cut Pro 4 supports both software- and hardware-based media I/O solutions.
The advanced architecture enables editing and finishing in a wide range of video
formats, frame rates, and resolutions. Audio and video subsystems can be either
FireWire or PCI based to support everything from DV and compressed offline
resolutions to fully uncompressed 10-bit SD and HD.
Sample-accurate A/V synchronization and frame-accurate I/O are handled through
QuickTime, with support for genlock to blackburst/reference on professional
FireWire- and PCI-based I/O devices. Final Cut Pro 4 supports a variety of interfaces
and protocols for precise deck control and accurate timecode.

Supported Formats
Because Final Cut Pro 4 is built on QuickTime, a wide variety of configuration options
and formats are available, giving users the flexibility to build a system that meets
their production requirements. Benefits of Final Cut Pro and QuickTime for audio and
video I/O include:
• Sample-accurate A/V synchronization
• Frame-accurate capture and output
• Professional timecode support
• Reliable and accurate device control (RS-422, RS-232, FireWire)
• Genlock to blackburst/reference
• Freedom to edit most media types and formats in software, even if the PCI or FireWire
hardware is not present
Supported device control protocols
Apple FireWire
Apple FireWire Basic
Sony RS-422
Sony RS-232 (SVO-2100) 9.6k
Sony RS-232 (SVO-2100) 19.2k
Sony RS-232 (UVW-1400) 9.6k

Sony RS-232 (UVW-1400) 19.2k
Sony VISCA
Sony LANC (via Addenda RS-4/L)
Panasonic RS-232
Panasonic RS-422
JVC RS-232
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Formats supported in Final Cut Pro 4
Format

Frame rate

Data rate

I/O

Use

OfflineRT

25, 29.97

Variable

FireWire

Offline for DV. Real-time down convert
from DV source on capture.

PCI

Offline for SD. Real-time down convert
from SD source on capture.*

PCI or FireWire

Offline for film and HD. Use Cinema
Tools to reverse telecine from 29.97
source.

PCI

Offline for HD. Real-time down convert
from HD source on capture.*

FireWire

Native DV editing.

PCI

Offline for SD. Real-time down convert
from SD source on capture.*

FireWire

Offline for film or HD from 29.97 source.
Use Cinema Tools for reverse telecine.

23.976, 24

DV and DVCPRO

25, 29.97

23.976, 24

Variable

3.6 MBps

2.8 MBps

Native Panasonic AG-DVX100 editing
(23.976 only).

DVCPRO50

Uncompressed SD

PCI

Offline for HD. Real-time down convert
from HD source on capture.*

25, 29.97

7 MBps

FireWire

Native DVCPRO50 editing.

23.976, 24

5.7 MBps

FireWire

Native Panasonic AJ-SDX900 editing
(23.976 only).

25, 29.97

20 MBps

Uncompressed HD 23.976, 24, 25,
29.97, 30

FireWire

8- and 10-bit SD online and finishing.

PCI

8- and 10-bit SD online and finishing.

90–150 MBps PCI

8- and 10-bit HD online and finishing.

* Not all capture cards support this function.

In addition to those listed above, third-party PCI cards support other online and offline
formats. These cards are available from a variety of manufacturers including AJA,
Aurora, Digital Voodoo, and Pinnacle.
Most formats can be used at several different frame rates. For example, Final Cut Pro 4
can work with DV at NTSC and PAL frame rates, or at 23.976 and 24 fps. DV can be
used as a low-bandwidth offline format for film and HD. Final Cut Pro 4 adds support
for working natively with Panasonic AG-DVX100 and AJ-SDX900 material and includes
new tools for both telecine and reverse telecine operations:
• Advanced pull-down removal during capture (2:3:3:2) for Panasonic AG-DVX100 and
AJ-SDX900 sources
• Real-time telecine insertion (3:2, 2:3:3:2, and 2:2:2:4) for FireWire output to monitor
• Real-time 3:2 removal supported through some capture cards
• Post-process 3:2 pull-down removal using Cinema Tools (now included)

Easy Setups
Final Cut Pro includes a library of “Easy Setups” that simplify system configuration.
Easy Setups combine audio and video I/O preferences. Custom Easy Setups can be
provided by third-party developers with their devices or created by the editor.
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OfflineRT
OfflineRT is based on the QuickTime Photo-JPEG codec and has been optimized for
Apple’s multiprocessor and Velocity Engine–based systems. Photo-JPEG compression
is variable (although the default is set to 660 Kbps, over 20:1 compression). Many
vendors ship SD and HD Easy Setups with compression ratios anywhere from 20:1
to 2:1. RT Extreme can be used with the default OfflineRT Easy Setups.

DV, DVCAM, DVCPRO, and DVCPRO50
25- and 50-Mbps DV formats
• DV, DVCAM, DVCPRO—4:1:1 YUV, 5:1
compression, fixed data rate of 25 Mbps
• DVCPRO50—4:2:2 YUV, 3.3:1 compression,
fixed data rate of 50 Mbps

Final Cut Pro 4 includes native support for both 25- and 50-Mbps DV formats.
Advanced pull-down modes are supported for working with Panasonic AG-DVX100
and AJ-SDX900 cameras. Final Cut Pro 4 adds real-time telecine capabilities for
outputting a 23.976- or 24-fps project to an NTSC or PAL monitor.

Broadcast-Quality Codecs
8- and 10-bit codecs
• Uncompressed 8-bit—4:2:2 YUV, SD and HD
• Uncompressed 10-bit—4:2:2 YUV, SD and HD

Fully uncompressed broadcast-quality codecs are now included with Final Cut Pro 4.
These new formats can be used as software codecs or in conjunction with third-party
capture cards. They are available to any QuickTime-compatible application on the system, allowing for the lossless movement of media across all production applications.

Log and Capture
Final Cut Pro 4 includes a professional log and capture interface that provides full
deck control, logging fields, and access to capture and media settings. Reel, clip,
scene and shot name information can be set to increment automatically, helping to
streamline the log and capture workflow.
Capture scratch information

Clip and capture preferences

Duration
Source
timecode

Logging
information
Set markers
while logging

Deck controls
In timecode
Out timecode
Single clip, on-the-fly, or
automated batch capture

New in version 4, Final Cut Pro can capture across breaks and gaps in timecode on
source tapes. When capturing across timecode breaks on a tape, Final Cut Pro 4
automatically increments the clip name; when capturing across gaps in timecode
on a tape, it increments the reel name.
When working with DV, Final Cut Pro 4 can detect when the camera started and
stopped; it creates subclips from captured media when the user selects the DV
Start/Stop Detect command in the Mark menu.
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Editing and Trimming

Key features
• Editing basics
• Trimming
• Ganged playback

The editing and trimming tools in Final Cut Pro 4 are seamlessly integrated into the
mode-free user interface for unparalleled speed between different editing functions.
Features that are the mainstay of professional editors—like three-point editing, JKL
keyboard navigation, match frame, multitrack trimming, and extend and split edit
functions—are all there. Unlike many legacy NLEs, access to these tools is not walled
off by individual modes. Final Cut Pro 4 allows direct manipulation, trimming, and
editing of clips in the Timeline. Enhancements include support for asymmetric trimming and dynamic (JKL) trimming.

Editing Basics
Several types of edits are available in Final Cut Pro 4. The most popular are:
• Insert. Adds media to the Timeline and pushes all other clips forward.
• Overwrite. Adds media to the Timeline and writes over existing media.
• Replace. Replaces a clip on the Timeline with one of equal length.
• Fit-to-fill. Edits a clip into a gap or predefined section on the Timeline with a speed
change so the clip fits.
• Superimpose. Adds video over the current clip on the next available track.
• Add. The razor blade tool lets you add edits through one clip or your entire stack of
tracks at once.
• Extend/Shorten. Edits can be lengthened or shortened with a simple click-and-drag
in the Timeline.
• Swap. Clips can be swapped on the Timeline.
Final Cut Pro 4 is flexible enough to let editors work any way they like. Edits can be
performed in several ways: using the mouse (drag and drop to the Timeline or the
Canvas), clicking buttons in the user interface, or with keyboard shortcuts. When you
drag elements from the Viewer to the Canvas, the Edit Overlay menu pops up, giving
you quick access to a wide selection of edits with a single movement of the mouse.
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Edit overlay

Edit buttons

Trimming
Final Cut Pro 4 includes robust and powerful trimming tools. Combined with the
different edit types, these tools allow professional editors to work quickly and efficiently. Trimming tools include:
• Ripple. Also known as a single-roll edit, the Ripple tool allows you to select one side
of an edit and extend or shorten it, thereby changing the length of your program.
• Roll. The Roll tool creates dual-roll edits in which both sides of an edit are changed
simultaneously. Adding to one side of the edit takes away from the other, preserving
the overall length of your program.
• Slip. The Slip tool allows you to change the contents of an edit on the Timeline
without affecting the clip’s position or duration in the program.
• Slide. The Slide tool performs a roll edit across three clips—shortening or extending
the clips on the left and right, while preserving the duration of the clip in the middle.
• Time remap. This hybrid effect/trimming tool lets you create variable speed changes
and ramps by slipping frames in time.
The different types of edits, along with the use of the advanced trimming tools
and the principles of three-point editing, allow many complex variations and edits,
including J or L cuts (prelapsed or prolapsed, in which the audio and video start at
different times), and back-timing of edits. The trimming tools can be mouse driven
or keyboard driven (numeric entry).
There are two fundamental ways to edit: The “yellow” way and the “red” way.
Advanced editors will use a combination of the two to achieve the desired results,
while beginners may want to stick to one or the other until they are comfortable
with the interaction between edit types, trimming tools, and synchronization.

Yellow method

Red method

Insert

Overwrite

Trimming edits

Ripple (single roll)

Roll (dual roll)

Deleting

Ripple delete (extract)

Delete (lift)

Results

Always changes length of program

Never changes length of program (unless
editing the first or last clip in a sequence)

Can move items out of sync

Never moves items out of sync

Adding edits
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Maintaining sync
Final Cut Pro 4 includes sync indicators that notify you when items fall out of sync as a
result of an edit operation. Control-clicking (or right-clicking) the sync indicators gives
you options for automatically moving or slipping either video or audio into sync.
Contextual menu
Sync indicators

In addition to sync indicators, there are track locks on the left side of the Timeline to
keep tracks from being edited and potentially moved out of sync. Track locking, along
with item linking, lets you create locked sync relationships, maintain them, or ignore
them altogether.
Asymmetric trimming
Final Cut Pro 4 now supports asymmetric trimming—an advanced technique that
gives editors a fast way to trim multiple clips in opposite directions. In the following
example, the head of the clip on V1 is selected and the tail of the gap (empty space)
on A1,2 is selected. Dragging the mouse right on V1 takes frames off the head of the
clip while simultaneously taking frames off the gap, thereby lengthening the audio on
A1,2 while shortening the video and still maintaining sync with V1.
Head of video selected

Tail of gap selected

Ripple V1 +20 frames

Resulting J cut

Dynamic trimming
Final Cut Pro 4 now includes dynamic trimming in the enhanced Trim Edit window.
When dynamic trimming is on, JKL controls in the Trim Edit window allow you to trim
on the fly. You can ripple or roll edits, as well as choose which side of an edit you’d like
to preview while trimming.
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Ganged Playback
The playheads in the Viewer and Canvas can be locked (ganged) so that they move
together while scrubbing through clips. Ganging is useful when modifying effects or
inspecting clips for potential trim operations. There are three ganging options:
• Follow. The playhead in the Viewer is locked to the playhead in the Canvas whenever
a sequence clip is opened into the Viewer, so that both playheads scrub together,
displaying the same frame.
• Open. This option is identical to Follow, except that as the playhead moves through
your sequence, the clip that appears at the current position of the playhead is automatically opened into the Viewer.
• Gang. When this option is selected, the offset between the current position of the
playhead in the Canvas and the current position of the playhead in the Viewer is
maintained as both playheads move together.
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Effects and Transitions

•
•
•
•

Key features
Real-time effects
Speed changes and time remapping
Render engine and image quality
Effects, transitions, and compositing

Real-Time Effects
Final Cut Pro 4 introduces an entirely new real-time architecture: RT Extreme.
This next-generation, advanced architecture is fully scalable and supports both
software- and hardware-based accelerated real-time effects processing. RT Extreme
takes advantage of multiple processors and is optimized for the Velocity Engine.
RT Extreme provides the following innovative features:
• Multistream. RT Extreme supports multiple streams of video effects. The number
of streams is limited only by your system configuration—the faster the system, the
more simultaneous streams of video you can work with in real time.
• Software based. Leverage the power of the Mac processors and OpenGL for DV
and OfflineRT multistream real-time effects. No additional hardware is required.
• NTSC/PAL output. DV and OfflineRT users can now view effects simultaneously
onscreen and on a video monitor via FireWire.
• Hardware support. Optional PCI- and FireWire-based video I/O solutions can take
advantage of RT Extreme for even greater real-time processing power.
• Creative control. The editor can choose between preview-quality effects for maximum simultaneous streams, and full-resolution effects for high-quality playback and
render-free editing to tape.
The RT Extreme pop-up menu in the Timeline gives editors several options for effects
processing. Guaranteed real-time effects playback (Safe) or Unlimited modes, as well as
video playback quality settings, can be adjusted here.
• Safe. In Safe mode, Final Cut Pro 4 provides guaranteed playback of real-time effects.
The number of streams and effects is based on the capabilities of your system.
• Unlimited. In Unlimited mode, Final Cut Pro 4 uses every bit of processing power
available, allowing you to stack up multiple streams of video. When Unlimited is
selected, nearly all 200 effects, filters, and transitions can be used in real time.
• Low and medium quality. The low- and medium-quality video playback selections
provide preview-quality real-time effects. The lower resolution allows the greatest
number of simultaneous streams and effects to be used.
• High quality. High-quality video playback provides full-resolution, full-frame-rate
playback of real-time effects. The higher-quality playback results in fewer simultaneous
streams and effects. When combining Safe mode and high-quality video playback,
many effects can be output to tape at full resolution without ever having to be
rendered.
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Speed Changes and Time Remapping
Final Cut Pro 4 now applies speed changes in real time with frame blending. In
addition to constant speed changes, the new Time Remap tool lets editors speed
up, slow down, reverse, or ramp playback speed over time. A revolutionary workflow
and user interface design allow time remap operations to be performed graphically
in the Timeline.
Time remap tools are complex and difficult to use on many systems. In Final Cut
Pro 4, time remapping is a variation on the Slip tool—allowing creative decisions
to be made directly in the Timeline. These creative decisions are based on the picture,
not on percentages, frame rates, or other complex parameters as in other NLEs.
With the Time Remap tool, the link between frames and time is not static, meaning
that 30 frames (25 in the case of PAL) do not have to be one second long. Similar to
the Slip tool, clicking a clip with the Time Remap tool and a simple movement of the
mouse lets the editor visually pick any frame from the source clip and place it anywhere in time. The result is either stretched (slow motion) or shortened (high-speed)
video on either side of the new keyframe.
When keyframe graphs are visible on the Timeline, visual tick marks indicate relative
speed. The closer the ticks are, the faster the video will play back. You can also manipulate Time Remap keyframes in the keyframe graph.

Keyframe graphs
with Bezier control

Speed ticks
(red is reverse)

Final Cut Pro 4 always gives the editor choices, and the Time Remap tool is no exception. It can be used as a creative tool directly in the Timeline as mentioned above, or
all values and parameters can be adjusted numerically in the Motion tab in the Viewer.
This gives editors total creative control and precise numeric accuracy when needed.

Precision numeric controls
for Time Remap
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Render Engine and Image Quality
Final Cut Pro 4 includes a new, advanced render engine designed to maximize
image quality, making it appropriate for professional finishing applications. Render
settings can be changed by selecting the Sequence menu > Sequence Settings and
clicking the Video Processing tab. The following render modes are supported on a
per-sequence basis:
•
•
•
•

8-bit RGB
8-bit YUV (default)
10-bit YUV
High Precision YUV (32-bit float)
Final Cut Pro 4 now includes its own fully uncompressed 8- and 10-bit SD and HD
formats (4:2:2 YUV) that are optimized for both multiple processors and the Velocity
Engine. Several I/O vendors have announced support for these new high-quality
formats. Using these formats helps to preserve maximum image quality when working
and finishing in professional broadcast formats with the Final Cut Pro 4 render engine.
When rendering, the codec is asked to convert the video data to 4:4:4:4 and pass it off
to the render engine. Final Cut Pro always renders at 4:4:4:4 (never 4:1:1 or 4:2:2). The
higher sampling rate is used to provide better results and maximum color precision.
High Precision YUV, also known as 32-bit float or HDR (High Dynamic Range), provides
the highest-quality renders for the following operations:

•
•
•
•
•
•
•
•
•
•
•
•
•
•

Color Corrector 2-way
Color Corrector 3-way
Broadcast Safe filter
Desaturate Highs/Lows
Proc Amp
Cross Dissolve
Gaussian Blur
Motion effects (except Drop Shadow and Motion Blur)
Composites (Normal mode, straight alpha)
Composites (Multiply mode, straight alpha)
Speed changes (with or without frame blending)
Highlight and Circle Light generators
Chroma Angle Key
Color Tints
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Effects, Transitions, and Compositing
Final Cut Pro 4 includes an entire suite of filters and effects for creating composites
and motion graphics. All filters and effects can be changed over time using keyframes.
Keyframes can be edited in the Motion or Filter tabs in the Viewer or using the new
keyframe graphs in the Timeline.
The following attributes can be copied,
pasted, or removed from any clip:
•
•
•
•
•
•
•
•
•
•

Content
Basic Motion
Crop
Distort
Opacity
Drop Shadow
Motion Blur
Filters
Speed
Clip Settings (capture)

Copy, paste, and remove attributes
When working with large projects or sequences that contain repetitive effects, filters,
and motion, it is often convenient to copy and paste the attributes from one clip to
another (or others). Similarly, attributes can be removed from a clip or clips. Keyframes
can be pasted as is or scaled to fit the duration of the clip they are being pasted onto.
Motion effects
Standard motion and picture-in-picture tools are included under the Motion tab in
the Viewer. Any object in the Timeline—a piece of video, a graphic, or text—can have
motion effects applied to it or composited over other clips. In the case of text and
graphics, Final Cut Pro 4 automatically recognizes the alpha channel if present.
Final Cut Pro 4 is context sensitive to allow maximum efficiency and a streamlined
workflow. When using Image+Wireframe view in the Canvas, the cursor changes
between move, rotate, scale, and pen tools depending on what portion of the image
you click.
Motion tab with all parameters expanded

Scale, Rotate,
Center, Anchor

Crop

Distort
Opacity
Drop Shadow

Motion Blur

Time Remap

Filters and transitions are available in menus or in the Browser under the Effects tab.
Filter parameters can be adjusted and keyframed by loading the clip in the Viewer
and selecting the Filters tab.
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Transitions
To apply a transition, select it from the Effects menu or drag it from the Browser to
any edit point in the Timeline. To adjust a transition, double-click it in the Timeline to
open it in the Viewer. Contextual menus (Control-click or right-click an item) can also
be used to adjust certain parameters. For example, Control-clicking a transition in the
Timeline allows you to change the duration or alignment of the transition.
Duration Alignment

A side of edit

Favorite

Transition

B side of edit

The transition can be slipped and extended or shortened in either the Timeline or
the Viewer. Alignment (centered, start on edit, or end on edit) can also be adjusted.
Once settings have been made, transitions and filters can be dragged to multiple clips
using the Favorite icon. They can also be dragged back into the bins and renamed for
later reuse.
Compositing
Final Cut Pro 4 includes many advanced compositing tools, giving video editors a
way to create motion graphics and composites without having to learn additional,
complex applications.
When importing graphics, Final Cut Pro 4 recognizes the alpha channel in an image
and lets the editor create straight composites with a simple drag and drop. Final Cut
Pro 4 also includes native support for multilayered Adobe Photoshop files. Photoshop
files are imported as sequences with each layer on a different video track. This makes
animating or adding effects to the Photoshop file (or independent layers of the file)
simple. Once a multilayered animation is completed, the sequence can be edited
into another sequence (the editor’s program, for example) as a nested item or as
individual tracks.
Composite modes
Final Cut Pro 4 supports a variety of composite modes, or methods of combining
multiple clips together. The most popular mode—called Normal—is the default used
when placing two images on top of one another (the top image covers all or part of
the image below it). To change a clip’s composite mode, Control-click (or right-click) it
in the Timeline and select the desired mode from the pop-up menu.
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The following composite modes are supported in Final Cut Pro 4.
Composite mode

Description

Normal

Displays the clip without any changes.

Add

Combines the color values of the selected clip with those
of the clip beneath it (not exceeding absolute white).

Subtract

Subtracts the color values of the selected clip from those
of the clip beneath it.

Difference

Subtracts the color values of the underlying clip from the
selected clip, displaying the absolute color values.

Multiply

Compares the color values for each pixel of the selected
clip with those of the clip beneath it and multiplies them
together.

Screen

Compares the color values for each pixel of the selected
clip with those of the clip beneath it in the Timeline and
multiplies the inverse of each.

Overlay

Wherever the color value is more than 128, Screen is
applied. Wherever the color value is less than 128, Multiply
is applied.

Hard Light

Darkens or lightens the colors of the selected clip,
depending on the color values for that clip.

Soft Light

Darkens or lightens the colors of the selected clip,
depending on the color values for that clip.

Darken

Compares the color values for each pixel of the selected
clip with those of the clip beneath it in the Timeline and
selects the darker of the two.

Lighten

Compares the color values for each pixel of the selected
clip with those of the clip beneath it in the Timeline and
selects the lighter of the two.

Travel Matte—Alpha or Luma

Applies a matte (an effect that uses information in one
layer of video to affect another layer) to the selected clip.

Transitions, filters, and effects
Video transitions
3D simulation
Cross Zoom
Cube Spin
Spin 3D
Spinback 3D
Swing
Zoom
Dissolve
Additive Dissolve
Cross Dissolve
Dip to Color Dissolve
Dither Dissolve
Fade In Fade Out Dissolve
Non-Additive Dissolve
Ripple Dissolve

FXScript DVEs
Band Slide
Cross Dissolve
Cube Spin
Double Page Peel
Flip
Page Peel
Page Peel 1/2
Page Peel 1/4
Slide
Softwipe
Split Side
Stretch
Swap Slide
Swing
Zoom/Rotate

Page Peel
Page Peel

Iris
Cross Iris
Diamond Iris
Oval Iris
Point Iris
Rectangle Iris
Star Iris

Slide
Band Slide
Box Slide
Center Split Slide
Multi Spin Slide
Push Slide
Spin Slide
Split Slide
Swap Slide

Map
Channel Map
Luminance Map

QuickTime
Channel Compositor
Chroma Key
Explode
Gradient Wipe
Implode
Iris
Matrix Wipe
Push
Radial
Slide
Wipe
Zoom

Stretch
Cross Stretch
Squeeze
Squeeze and Stretch
Stretch
Wipe
Band Wipe
Center Wipe
Checker Wipe
Checkerboard Wipe
Clock Wipe
Edge Wipe
Gradient Wipe
Inset Wipe
Jaws Wipe
Random Edge Wipe
V Wipe
Venetian Blind Wipe
Wrap Wipe
Zig-Zag Wipe
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Video filters
Blur
Gaussian Blur
Radial Blur
Wind Blur
Zoom Blur
Border
Basic Border
Bevel
Channel
Arithmetic
Channel Blur
Channel Offset
Color Offset
Compound Arithmetic
Invert
Color correction
Broadcast Safe
Color Corrector
Color Corrector 3-way
Desaturate Highlights
Desaturate Lows
RGB Balance
Distort
Bumpmap
Cylinder
Displace
Fisheye
Pond Ripple
Ripple
Wave
Whirlpool

FXScript DVEs
Brightness/Contrast
Color Balance
Displace
Distort
Double Border
Four-Point Garbage
Matte
Replicate
Roll/Scroll (Title)
White Balance
Widescreen
FXScript layered DVEs
Band Slide
Page Peel
Page Peel 1/2
Page Peel 1/4
Slide
Softwipe
Split Slide
Stretch
Swing
Zoom/Rotate
Image control
Brightness and Contrast
(Bezier)
Color Balance
Desaturate
Gamma Correction
Levels
Proc Amp
Sepia
Tint

Key
Blue and Green Screen
Chroma Keyer
Color Key
Color Smoothing—4:1:1
Color Smoothing—4:2:2
Difference Matte
Luma Key
Spill Suppressor—Blue
Spill Suppressor—Green

Emboss
General Convolution
HSL Balance
Lens Flare
RGB Balance
Sharpen

Matte
Eight-Point Garbage Matte
Extract
Four-Point Garbage Matte
Image Mask
Mask Feather
Mask Shape
Matte Choker
Soft Edges
Widescreen

Stylize
Anti-alias
Diffuse
Emboss
Find Edges
Posterize
Replicate
Solarize

Perspective
Basic 3D
Curl
Flop
Mirror
Rotate

Sharpen
Sharpen
Unsharp Mask

Video
Blink
De-Interlace
Flicker Filter
Image Stabilizer
Stop Motion Blur
Strobe
Timecode Print
View Finder

QuickTime
Blur
Brightness and Contrast
Color Style
Color Tint
ColorSync
Edge Detection

Video generators
Bars and Tone (NTSC)
Bars and Tone (PAL)
Slug
Matte
Color

Others
More Bars & Signals
Render
Custom Gradient
Gradient
Highlight
Noise
Particle Noise

Shapes
Circle
Oval
Rectangle
Square

Text
Crawl
Lower Third
Outline Text
Scrolling Text
Text
Typewriter
Title 3D (Boris)
Title Crawl
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Audio

Key features
• Mixing and automation
• Fader automation and keyframe thinning
• Multichannel audio routing and stereo
downmix
• Exporting
• Effects
• Voiceover

Final Cut Pro 4 includes an entirely new audio architecture built on the highperformance, ultra-low-latency Core Audio engine in Mac OS X. With Mac OS X and
Final Cut Pro 4, integrated professional-level audio is now available to video editors.
From a new onscreen mixing console to multichannel audio output, routing, and
export capabilities, Final Cut Pro 4 delivers power previously available only in
dedicated digital audio workstations.
Sample-rate conversions are handled on the fly and in real time as necessary. To
work with 24-bit audio sources, files must be imported from disk (at this time, log
and capture/voiceover is not supported for sample resolution greater than 16-bit).
High-resolution audio can be edited and exported losslessly as individual audio files
to dedicated DAWs (Emagic Logic, for example). In addition, 16- and 24-bit audio
track sample data, along with sequence edit information, can be exported via OMF
2.0 for Pro Tools and other compatible applications.

Mixing and Automation
Final Cut Pro 4 has a new onscreen mixer that supports a staggering 99 tracks; each
track on the mixer contains a fader, level meter, mute/solo buttons, and pan controls.
A separate master section in the mixer handles adjustment of the overall level of
the mix. Each track in the mixer includes peak-hold level indicators to provide
enhanced precision during the mixing process. Besides multichannel meters and a
mute control, the master output section includes peak clipping indicators to help
achieve the maximum dynamic range for the mix. Up to four separate track selection
views can be defined, allowing editors wide flexibility when organizing large multitrack mixing jobs.
Custom views

Pan

Mute/Solo
Keyframe buttons

Inactive tracks
Master levels, outputs,
fader, and peak indicators

Track faders

Track gain
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Fader Automation and Keyframe Thinning
The faders in the Final Cut Pro 4 mixer use a new continuously varying log scale for
more intuitive adjustment of levels and a wider sweet spot around unity gain. Fader
automation lets editors mix their audio in real time and record the mix gestures. Fader
automation can be recorded in three ways: with all keyframes, with reduced keyframes
using an exclusive new algorithm, or as peaks (fader direction change) only. In an
industry first on a professional NLE, recording with reduced, or thinned, keyframes
happens in real time. Keyframe reduction allows much more efficient editing when
level ramps need to be tweaked after recording.

Multichannel Audio Routing and Stereo Downmix
Any of the 99 available tracks in a sequence can be routed to individual mono or
stereo groups from a maximum 24 channels of discrete output. Editors can configure
pairs of available audio output channels into mono and stereo groups and assign multiple tracks to any group for submix capability. An attenuation level can be specified
for each stereo and mono output group when the user wants the ability to switch
between discrete multichannel output and stereo downmix.
The stereo downmix button in the mixer allows the user to monitor multichannel
projects when working on a portable computer or in an editing situation where a
multichannel audio interface is inaccessible, all without changing the mix levels for
individual tracks or the master output.

Exporting
When exporting audio for use in other editing environments, Final Cut Pro 4 supports
both 16- and 24-bit sample formats for OMF 2.0. With OMF export, sequence edit
information (such as clip placement and handles) can be interchanged in addition
to the audio track sample data. You can also export 16- or 24-bit AIFF files for each
output group’s independent submix. In addition, 24-bit AIFF, WAVE, and SDII files can
be imported into Final Cut Pro 4 at full sample resolution. Sample-rate conversions
during export use an advanced, high-quality conversion algorithm for pristine audio
master files.

Effects
In addition to its own audio-sweetening filters, Final Cut Pro 4 now supports Apple’s
Audio Units plug-in architecture (see www.apple.com/finalcutpro for details), allowing
for a selection of external plug-in effects. Most audio filters can be adjusted in real
time for audible feedback during mixing, and real-time parameters can be keyframe
automated through either recording during playback or standard editing procedures.
Final Cut Pro 4 also creates professional, logarithmic audio fades.
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Audio transitions and filters
Audio transitions
Cross Fade (0 dB)
Cross Fade (+3 dB)
Audio filters:
Apple Audio Units
AUBandpass
AUDelay
AUGraphicEQ

AUHighShelfFilter
AUHipass
AULowpass
AULowShelfFilter
AUParametricEQ
AUPeakLimiter

Audio filters:
Final Cut Pro
Band Pass Filter
Compressor/Limiter
DC Notch
Echo
Expander/Noise Gate
High Pass Filter
High Shelf Filter

Hum Remover
Low Pass Filter
Low Shelf Filter
Notch Filter
Parametric Equalizer
Reverberation
3 Band Equalizer
Vocal DeEsser
Vocal DePopper

Voiceover
The Voice Over tool lets editors punch audio (overdub) directly into a sequence in
real time using any available Mac OS X–compatible audio input device, such as USB
microphones, FireWire audio interfaces, DV, or through a PCI-based capture card. The
Voice Over tool is accessible from the Tool Bench, selected in the Tools menu.
Controls: review,
record, and discard

Status window
Filename and location
Input settings
Headphone settings

When using the Voice Over tool, the narrator or other audio talent wears headphones
connected to the system and records using the audio input device. While listening
to the sequence’s audio mix through headphones, the narrator hears audible beats
providing count-in and count-out cues during the recording session as the corresponding video is displayed.
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Media Management

•
•
•
•

Key features
Working with clips
Media preferences
Media Manager
Render Manager

Final Cut Pro 4 includes powerful, intuitive content management tools that let editors
consolidate, relink, mark, and store digital assets for quick retrieval. In addition to
content and file management tools, several new features enable greatly improved
workflows through more efficient use of clips, Browser, bin, and Timeline information.

Working with Clips
Managing large numbers of clips and media for complex projects can be a daunting
task in many NLEs. Final Cut Pro 4 includes several different ways to help you manage
and work with clips. Whether you are a film editor or a videographer, mastery of these
tools will greatly simplify editorial tasks.
Master and affiliate clips
Final Cut Pro 4 introduces master/affiliate clip relationships. The first instance of a
clip that is captured or imported into a project is a master clip. Editing a master clip
into a sequence or duplicating it in the Browser results in the creation of a sequence
clip or duplicate clip that is an affiliate of the original master clip. A relationship exists
between the original master clip in the Browser and all edited or duplicate affiliates
of that clip that appear in every sequence and in every other bin of that project.
Media files on disk are not duplicated when affiliates are created; affiliates reference
the master clips source media file.
As a result of the relationship between master and affiliate clips, changes made to
certain properties of either the master clip or the affiliate (such as clip name, reel
name, online/offline status, or timecode) are automatically made to all affiliated clips
within the current project.
Master and affiliate clips are especially useful after capturing large amounts of media.
For example, an assistant editor might log and capture clips that are organized in
bins based on reel name. The editor might want to organize the clips differently—
by shot/scene or any other criteria. Creating affiliate clips in new bins preserves both
organization schemas without duplicating media files on the disk.
Merged clips
A merged clip is a clip that links to more than one source media file on disk. Merged
clips allow you to synchronize the audio and video items of footage shot via dual
system recording. Instead of syncing video and audio before capturing, you can
capture each separately and merge them together in Final Cut Pro. Merged clips can
be synchronized using their timecode, In points, or Out points and can contain one
video and 24 audio items (12 stereo or 24 mono audio items).
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Modifying timecode
Final Cut Pro 4 adds support for modification of timecode with mixed rates. You can
modify the Reel, Timecode, Aux 1, and Aux 2 timecode information for a clip. This
permanently changes the timecode for the source media on disk.
Start point for new timecode

Clip name
Source/Aux settings

Reel/Roll
Timecode

Format
Frame rate

Markers
Final Cut Pro 4 supports several different marker types. Standard markers, also referred
to as locators, can be applied to source clips, sequences, or sequence clips. In addition
to standard markers, you can create chapter, compression, and score markers. These
special marker types can be exported with media to DVD Studio Pro, Compressor, and
Soundtrack, respectively.
Marker name
Comments
Start/duration
Special markers

Reconnecting media
If media is not found when a project is open, Final Cut Pro 4 automatically searches
the available drives to locate the media and reconnect it. If the appropriate media is
still not found, Final Cut Pro prompts you to select the location of the media files.
Conversely, the Make Offline command lets you take media offline inside a project
and gives you three options:
• Leave media on disk
• Move media to Trash (but do not empty)
• Delete media entirely
Item properties
Detailed information about items in a Final Cut Pro project is available by Control- or
right-clicking any item and selecting Item Properties from the pop-up menu. Multiple
clips in a sequence can be selected at once and viewed in the Item Properties window. Each clip will have a column in the window. Differences between one clip and
the item directly left of it are in boldface, making it easy to see how selected clips
differ at a glance.
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Media Preferences
Final Cut Pro 4 includes several preferences for managing disks and render files. These
settings let editors select multiple scratch disks for capturing and storing audio, video,
cache, and render files. Final Cut Pro 4 is designed so editors never need to leave the
program and search through disks manually to manage or clean up media files. It is
still important, however, to understand how Final Cut Pro organizes media and uses
disk space.
Scratch disks
Scratch disks are used for storing audio and video media files, cache files, and project
documents. Final Cut Pro 4 allows you to select up to 12 scratch disks. Optionally,
audio and video can be captured to separate files (which creates merged clips). Audio
and video render files can also be stored on separate drives.
Optionally capture video, audio,
and render files to different drives

Set up to 12 scratch disks
Cache file locations
Autosave Vault location

If a scratch disk is not found or becomes unavailable, Final Cut Pro 4 warns you and
gives you three options:
• Quit
• Set scratch disks (to choose a new scratch disk)
• Check again (allowing you to reconnect or start up your scratch disk)
The default location for media that has been logged and captured or rendered in Final
Cut Pro is the user’s Documents folder. This location can be changed in the System
Settings preferences located in the Final Cut Pro menu. Scratch disks contain a folder
called Final Cut Pro Documents that includes the following subfolders:
•
•
•
•
•
•

Audio Render Files
Autosave Vault
Capture Scratch
Render Files
Thumbnail Cache Files
Waveform Cache Files
Files in these folders are organized by project name. Media imported from other
applications can be stored anywhere.
Autosave Vault and Auto Render
The Autosave Vault is designed to help protect you in case a project is accidentally
closed without saving or in the unlikely event of a system or application failure. The
new Auto Render feature automatically begins rendering project sequences after a
predetermined period of inactivity. Both Autosave and Auto Render settings are in the
Final Cut Pro menu > User Preferences.
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Media Manager
The Media Manager is an advanced tool used for project, sequence, or clip level media
operations (depending on what is selected in the Browser). The Media Manager allows
you to perform the following operations:
• Copy. Copies entire projects, sequences, or clips from one location to another.
• Move. Moves entire projects, sequences, or clips from one location to another.
• Recompress. Converts entire projects, sequences, or clips from one format to another.
Useful for creating a more highly compressed version of a project using OfflineRT for
editing on a portable computer.
• Use existing. Keeps existing files in their location, but consolidates and trims media
in a project based on the selections made in the Media Manager window.
• Create offline. Creates a version of the project or selected sequences without any
attached media. Useful for moving a completed project from one system to another
for online and finishing work.
You access the Media Manager by making a selection in the Browser and selecting
Media Manager in the File menu (or by Control- or right-clicking the selection in the
Browser). The operations above can be customized by telling Final Cut Pro 4 whether
it should delete unused media, leave handles on clips, include affiliate clips outside
the selected media, or change file names to match clip names in the Browser.

Summary
Disk space information
Media operation
Options

New project information
and media destination

Media Manager operations can be destructive and, if not used properly, cost hours
in lost time. There is a plain-language summary at the top of the Media Manager
window that you should read before clicking OK. The summary gives explicit information about the type of operation to be performed and how it will affect media
files on your disks.

Render Manager
The Render Manager (in the Tools menu) lets you free up drive space by deleting
unwanted render files from older projects. The Render Manager organizes render
files by project name and sequence name. Check Remove for the desired items to
free up the amount of disk space listed next to each item.
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Color Correction

Key features
• Color correction filters and tools
• Frame Viewer
• Scopes and monitors

Final Cut Pro 4 includes a comprehensive suite of corrective finishing tools—color
correction filters, range checking, scopes and monitors, and a new Frame Viewer for
comparing shots—many of which operate in real time using RT Extreme for DV and
uncompressed SD formats.
Final Cut Pro color correctors operate in YUV and all image processing is done at
4:4:4:4. Bit depth is determined by sequence settings, media type, and video processing preferences (8-, 10-, or 32-bit float).

Color Correction Filters and Tools
Color correction filters are in the Browser under the Effects tab. Go to Video Filters >
Color Correction. The following filters, all of which can be keyframed, are specifically
designed for color correction tasks.

Filter

Description

Broadcast Safe

Used for quickly bringing clips or entire sequences into
broadcast-safe ranges.

Color Corrector

A two-way color corrector used for adjusting the angle
of hue and overall balance of an image.

Color Corrector (3-way)

A three-way color correction filter used for adjusting the
hue of lows, mids, and highs independently.

Desaturate Highlights

Removes color casts from areas of high luminance.

Desaturate Lows

Removes color casts from areas of low luminance.

RGB Balance

Allows individual control of lows, mids, and highs for
each channel: red, green, and blue.

These filters can be combined with Image Control filters, as well as Matte and Key
filters. In total, this assortment of filters makes Final Cut Pro 4 exceptionally powerful
and flexible for corrective finishing work.
The Color Corrector and Color Corrector (3-way) filters have numeric controls as
well as visual user interfaces. All parameters can be changed over time through the
use of keyframes. Both have Limit Effect controls, allowing the editor to isolate color
correction operations to specific areas of an image based on chrominance, luminance,
saturation, or any combination thereof. New in Final Cut Pro 4, Edge Thinning and
Softening adjustments have been added to the Limit Effect controls of both color
correctors.
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Color Corrector (3-way)
Numeric/Visual UI toggle
Copy settings forward/back
one or two clips
Blacks, Mids, Whites
hue adjustments
Reset buttons

Level sliders

Saturation slider
Eyedropper, key view toggle,
and invert matte buttons

Limit Effect controls
Thinning/Softening
Limit by saturation

Limit by luminance

Limit by chrominance

In addition to the corrective filters and effects, Final Cut Pro 4 includes range checking
functionality, hardware-accurate video scopes and monitors, and a new Frame Viewer
for comparing shots. Range checking can be turned on in the View menu and is used
to highlight excess luminance or chrominance in the video. Areas of an image that are
above 90% of the legal limit are marked with green zebra stripes. Red zebra stripes
indicate portions of the image that are over 100%, or illegal. A green checkmark indicates that the image falls within the 0–90% legal range; a checkmark with an up arrow
means the image is using 0–100% of the legal range; and a yellow warning “!” tells you
that the image contains areas that are illegal, or above 100%.

Frame Viewer
Final Cut Pro 4 includes a new tool called the Frame Viewer, which provides a simple
interface for comparing shots when color correcting or doing effects work. In the
Frame Viewer, editors can select whether they are looking at:
•
•
•
•
•
•
•
•

Second edit back
Previous edit
Current frame
Current frame without filters
Next edit
Second edit forward
In point
Out point
Multiple Frame Viewers can be open at the same time, enabling customized workflows
in which several shots can be compared at once. The Frame Viewer also includes controls for splitting the screen horizontally and vertically. The split screen can be resized
and moved around within the Frame Viewer window for even greater control.
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The Frame Viewer contains two boxes that hold clips: a “green” box and a “blue” box.
Straight horizontal and vertical splits can be viewed using the buttons at the bottom
of the Frame Viewer window. Editors can also adjust the size and position of the
green and blue boxes by dragging to create custom views in the Frame Viewer. This
is useful when trying to compare specific portions of shots for color correcting, as
shown below.
Frame Viewer showing two shots

Green box
(left clip)
resized

Image split controls

Shot selection menu

Scopes and Monitors
Final Cut Pro 4 includes hardware-accurate scopes and monitors for assessing the
levels, colors, and integrity of the video signal. Input levels for the scopes are defined
by the settings and preferences for the video I/O hardware attached to the edit
system. Any combination of the scopes can be shown and, like the Frame Viewer,
multiple scopes can be open at the same time. There are four scopes to choose from:
•
•
•
•

Vectorscope
Histogram
Waveform Monitor
RGB Parade

Vectorscope

Histogram

Waveform
Monitor

RGB Parade
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Output

Key features
• Video
• Compressor
• MPEG-2

Video
Final Cut Pro 4 supports a variety of output options, including broadcast-quality
codecs for studio-quality finishing and distribution. The application now includes
8- and 10-bit uncompressed (YUV 4:2:2) SD and HD codecs, a DVCPRO50 (4:2:2)
codec, and a newly optimized, high-quality MPEG-2 codec.
Projects can be output frame-accurately to professional decks with full device control
(for a list of supported formats and device control protocols, see the tables on pages
18 and19). DV “edit-to-tape” operations can be done with both DV cameras and decks
(not all DV devices support frame-accurate edits and insert edits to tape).
QuickTime is the multimedia architecture on which Final Cut Pro 4 is built. This
enables fast and easy exporting of sequence data to many different audio and video
formats for web streaming, multimedia production, or DVD authoring.

Compressor
Compressor provides automated media encoding for everything from DVD authoring
to generating video for the web. Compressor works as a stand-alone application or
as an integrated encoding option that you can use within Final Cut Pro 4, so you
can choose the workflow that best suits your style. With Compressor, you can encode
digital media directly from the Final Cut Pro 4 Timeline. When you open Compressor
from the Final Cut Pro Export menu, you’re giving it direct access to your digital
content—even real-time effects in Final Cut Pro 4 can be encoded in a single pass.
This integration means that it’s no longer necessary to create an intermediate file to
be encoded by another application. That saves time (because there’s no need to
export), saves hard disk space (since an intermediate file is no longer required), and
produces pristine-quality video (since you avoid the generational loss that occurs
when exporting to an intermediate file).
High-performance encoding engine
Compressor takes full advantage of multiple processors and the Velocity Engine for
high-performance encoding.
QuickTime MPEG-4 and AAC audio streaming support
Compressor lets you encode projects using MPEG-4, the next-generation multimedia
standard. With MPEG-4 encoding, you can deliver high-quality audio and video
streams over virtually the entire spectrum of bandwidths—from cell phone to broadband and beyond.
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Velocity Engine–accelerated filtering
Compressor includes image-processing filters to add to your transcoding jobs. The
Velocity Engine–accelerated filters include Brightness Contrast, Deinterlacing, Gamma
Correction, Color Correction, Black and White Clip, Letter Box, Text Overlay, Watermark,
and intelligent Chroma Noise Removal.
Preview window
Clips can be played back with filter changes in real time. This dynamic playback means
there is less guesswork in determining the final look of the encoded output. The
Preview window can also be used as a split-screen viewer to compare source and
image-processed content side by side.
Presets
Compressor ships with a number of presets for encoding to MPEG-2, MPEG-4, and
other QuickTime formats. You can apply these presets to your source media by selecting the Preset pop-up menu in the Batch window. As soon as you select a preset, the
Preview window displays the split screen, which shows you the original image on the
left and a preview of the encoded image on the right. You can apply multiple presets
in cases where you want multiple output formats from a single piece of source media.
When you select a different preset in the Batch window, the Preview window switches
to show you the current selection in the split-screen view.
The Presets window also contains the encoder and filtering panes involved in creating
and modifying presets and other settings related to your output media file, such as
geometry controls.
Droplets
Droplets allow you to transcode a media file by just dragging the source media file or
multiple files over a Droplet icon. Compressor can create droplets from an existing
preset or group of presets.
Batch window
When you use Compressor in Final Cut Pro 4, sequences are automatically loaded into
the Batch window, but you can drag any type of QuickTime media into the window at
any time. Once the files are in the Batch window, you can choose a preset for each
media file using the quick-select button in the Preset column.
Batch window

Preview window

Quick-select
button
Split-screen
view

Presets
window
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MPEG-2
The MPEG-2 codec in Compressor is a high-quality, second-generation Apple encoder
that creates pristine video at a fraction of the data rates previously required. The
new MPEG-2 encoder supports one- and two-pass VBR (variable bit rate) encoding,
advanced motion estimation, and the ability to control GOP (group of pictures) size
and structure.

Presets
Filters

VBR

Two-pass variable bit rate (VBR) encoding
The two-pass VBR encoding method analyzes the entire file on the first pass and then
uses that data during a second-pass encoding stage to intelligently distribute bit allocation per frame. The result is an optimized MPEG-2 file with consistent visual quality.
Advanced motion estimation technology
An advanced temporal prediction technique identifies areas of a frame that need to
be compressed based on changes between frames.
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Film

Final Cut Pro 4 has features specifically designed for film editors. Cinema Tools 2
is included for managing the data associated with projects shot on film and HD.
Final Cut Pro now provides features such as dupe detection in the Timeline, merged
clips, and auxiliary timecode support. For details on these features, see “Editing and
Trimming” on page 21.
Cinema Tools 2 is a database-driven application that tracks the relationship between
the original film and sound and its digitized video counterpart. It also enables frameaccurate 24-fps editing by offering powerful reverse telecine and conforming features.
Cinema Tools can generate the lists needed by negative cutters to conform the film.
New in Cinema Tools 2 is support for ink numbers and film change lists. In addition,
Cinema Tools continues to support the import and export of telecine log files (ALE,
FLX) as well as batch lists. There are batch reverse telecine features and conforming
tools, as well as EDL conversions (24 to 29.97) and audio EDL export options.
Cinema Tools can generate the following lists:
•
•
•
•
•
•
•

Cut list
Optical list
Pull list
Dupe list
Change list
Audio EDL
Missing elements list
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Extensibility

Key features
• XML interchange
• OMF and AAF
• I/O framework

Final Cut Pro 4 is one of the most extensible professional NLEs available. An entire
ecosystem of tools from customers and developers is growing around Final Cut Pro.
For editors, Final Cut Pro 4 includes support for:
• QuickTime. Apple’s ubiquitous multimedia architecture for seamlessly sharing media
files with other applications.
• EDLs. Support for Sony, Grass Valley, and CMX EDLs with improved accuracy for speed
changes and still frames.
• FXScript. The visual effects scripting language in Final Cut Pro 4. Most Apple effects,
filters, and transitions are written using FXScript; the code can be opened in the
FXScript Editor and used as a reference for developing custom scripts.
• After Effects plug-ins. Most Adobe After Effects plug-ins that are compatible with
version 3 of the After Effects plug-in specification work with Final Cut Pro 4.
• Audio Units. Mac OS X Audio Units provide high-performance, low-latency audio
plug-ins for Final Cut Pro 4. Details on implementation and compatibility are available
on Apple’s website.
For developers, Final Cut Pro 4 provides greatly enhanced extensibility that can be
customized for production pipelines or new devices.

XML Interchange
For developers and high-end studios or production facilities, Final Cut Pro 4 introduces
a new XML-based interchange format. The XML interchange format bridges the gap
between Final Cut Pro 4 and disparate edit systems, asset management databases,
and custom post-production pipelines. Complete projects can be generated from
Final Cut Pro 4 or from other applications and systems that can create XML files.
The XML interchange format can be used to describe every aspect of a program,
from edits and transitions to effects, color correction settings, and keyframe data. You
can seamlessly share project, bin, sequence, clip, and media data generated by Final
Cut Pro 4 with any other application or system that supports XML, including other
nonlinear editors, database systems, and broadcast servers. You can track media elements throughout the production process by combining XML and QuickTime, which
support media-attached metadata.
Complete documentation, along with a beta version, will be available in summer
2003. XML interchange functionality will be provided through a software update
for registered Final Cut Pro 4 customers.
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XML

The XML interchange format enables interoperability between Final Cut Pro 4 and nonlinear
editors, asset management databases, and custom post-production pipelines.

OMF and AAF
Final Cut Pro 4 continues to support native export of Audio OMF (see “Audio” on page
32 for more information). The XML interchange format gives developers the tools they
need to create custom import/export components for Final Cut Pro. For example,
Automatic Duck is creating an AAF import/export component for Final Cut Pro 4 that
will be freely available to all registered users via Apple’s website in fall 2003.
Apple is actively working with Automatic Duck and companies like Quantel to ensure
the accuracy of the AAF components that are built on the XML interchange format.

I/O Framework
The new I/O framework in Final Cut Pro 4, available for developers, enables exciting
new audio and video devices based on FireWire. Devices using the I/O framework can
transfer fully uncompressed 8- and 10-bit standard definition video over FireWire.
The first developer to take advantage of the I/O framework is AJA. Its product, called
“Io,” uses the new uncompressed 8- and 10-bit SD formats in Final Cut Pro 4 to provide
professional connectivity options for standard-definition broadcast customers. Io
includes full support for professional deck control, industry-leading A/V synchronization, and genlock to blackburst. A single connection to the Mac via FireWire makes
adding professional video I/O as simple as connecting a mouse or keyboard.
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LiveType

Developed for Final Cut Pro 4 users, LiveType is a full-featured, professional-quality
titling application that allows you to create dynamic, animated titles quickly and
easily. With an innovative new font standard—LiveFonts, the first 32-bit animated
fonts, available only on the Mac—and a new way to create effects, LiveType is simple
enough for the first-time user and powerful enough for the professional. LiveType
comes with 27 LiveFonts, as well as easily adapted project templates, customizable
keyframed effects, and a huge library of animated content. LiveType also includes
alpha channel support, scalability, dynamic individual character control, and frameaccurate registration with Final Cut Pro projects.
Professionally designed templates get your project off to a fast start (you can build
and save your own templates as well). LiveType templates combine the various elements available in the application, including LiveFonts, system fonts, and animated
textures and objects, into ready-to-use, customizable projects for your video.
A new font standard
LiveFonts are a new kind of font. Designed by professional animators, LiveFonts let
you type out sophisticated animated font styles as easily as you’d type out a system
font. And because they’re created in 32-bit alpha channel, they key right over video.
LiveType features 27 LiveFont styles and a powerful FontMaker utility for creating
your own LiveFonts from QuickTime movies. LiveType also includes vector-based font
handling for your system fonts.
Royalty-free content
LiveType comes with 350 broadcast-quality animated textures and objects that you
can use in your projects, allowing even nonanimators to produce professional-level
content right out of the box. The textures can be used full screen, matted inside text
or objects, or scaled down for use in lower thirds.
Customizable effects
Effects in LiveType are like digital building blocks—modular behaviors that include
movement, transformation, and timing parameters. The 150 prebuilt effects that come
with LiveType give you the power to add fades, zooms, rotations, and motion to your
titles, and you can create your own styles by adjusting these effects in the LiveType
interface. You can also use LiveType to create effects dynamically on the fly, and even
save them for use in future projects. Its unique approach to keyframe animation
makes creating effects quick and easy.
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Timing is everything
With LiveType, animation is easier than ever before. Each keyframe in an effect contains all the parameters for that moment in time, eliminating the time-consuming
hassle of long keyframe stacks. And since LiveType treats every character of the word
as a separate layer, powerful timing features such as sequencing give you the creative
freedom to move single characters within a text block with individual timing elements,
so you’re not limited to blocks of text that fly around the screen as one image. The
live wireframe preview lets you see your work in real time.
Flexible and compatible
You can import clips from Final Cut Pro 4 complete with markers, so it’s easy to synchronize your titles to important video and audio transitions in your video projects.
LiveType also imports and exports all QuickTime-supported file formats, including
Adobe Photoshop, JPEG, TIFF, and PICT. You can animate your own graphics in
LiveType quickly and easily.

LiveType at a Glance
Creating full-motion, animated fonts has never been easier. LiveType delivers professional-quality titles to your Final Cut Pro 4 video projects quickly and easily. With its
27 included LiveFonts—along with professional templates—LiveType lets you create
the effects you need, all within an intuitive, easy-to-use interface.
Canvas

Text entry box

Inspector

Media Browser

Live wireframe
preview

Project tab
Track grouping
buttons

Timeline

Zoom slider
Enable/Disable

Track Effect Keyframe

Timecode
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A wide range of options
LiveType creates a QuickTime movie that you import into your Final Cut Pro bin like
any other file, and exports your project with or without an alpha channel, making it
available to your Final Cut Pro 4 projects.
Flexible yet powerful, LiveType allows you to set up your own project size and resolution, so you can work in NTSC, PAL, HD, or a custom setting of your choosing.
LiveType supports all of your system fonts, including PostScript and TrueType fonts,
making it possible to create an even wider spectrum of titling effects. It also imports
and exports all QuickTime-supported file formats, including Adobe Photoshop. That
means you can add your own media files to any LiveType project.
LiveFonts and effects
LiveFonts are fonts designed specifically for use in video. The 27 LiveFonts that ship
with LiveType were created in other applications by professional animators. For
example, the LiveFont Clay was shot on video and is actual footage of a man’s hands
modeling letters in clay. Effects are combinations of parameters such as blur, rotation,
and opacity. You can apply effects to any element, including LiveFonts.
LiveType includes the FontMaker utility and instructions for compiling your own
LiveFonts. Anything that can be a QuickTime movie can be made into LiveFonts, from
hand-drawn characters to images shot with a camera. The utility allows you to create
your own LiveFonts, which are royalty free and yours to distribute.
You can customize the included effects and save your changes as new effects, or
start your own effects from scratch. Once you have saved an effect, you can apply it
to multiple elements in the same project, use it on other projects, and share it with
other LiveType users. Since LiveType effects are modular—not project based—they
can be transferred independently of the application. Several of the LiveFonts that ship
with LiveType were created originally in 3D animation applications; however, LiveType
is a 2D animation environment. Final Cut Pro 4 includes Calligraphy, an excellent
plug-in for creating extruded system font looks.
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Soundtrack

Soundtrack lets you create high-quality, royalty-free music for your Final Cut Pro 4
projects quickly and easily. As a production tool, it’s perfect for creating 15-, 30-, and
60-second original music content, promotion spots, bumpers, and interstitials, as well
as longer programs.
Featuring a friendly user interface and a workflow designed specifically for working
with Final Cut Pro 4, Soundtrack enables you to create original music scores on your
own—no professional musical experience is necessary. And because Soundtrack lets
you develop your music scores in real time, you can quickly evaluate dozens of
alternatives before you export your composition.
Soundtrack gives you the power to develop professional music yourself, allowing you
to retain greater control of your entire project.
Thousands of royalty-free instrument and sound effects
Soundtrack includes over 4000 professionally recorded, royalty-free instrument and
sound effects that you can start using immediately to create original, high-quality
music scores in a variety of genres and moods. Since the music is prelicensed, you’re
free to distribute and resell your compositions however you see fit.
Professional real-time audio effects
Soundtrack also includes more than 30 powerful audio plug-ins, such as Reverb, EQ,
Delay, and Chorus, giving you even more creative options for mixing, as well as specialized effects from Emagic Logic Platinum like SubBass, Bitcrusher, and AutoFilter.
And since Soundtrack supports the Mac OS X Audio Units plug-in architecture, you
can expand your audio capabilities even further with additional third-party audio
effects developed using Apple’s open-standard plug-in format.
Intelligent search engine
Soundtrack uses an advanced search engine to find music loops instantly based on
instrument, genre, or mood. Regardless of how many loops you have, or where they’re
located on your hard drive or network, the sounds you need are only a click away.
The search engine works with the new Apple Loops or any other AIFF, WAV, and Acid
libraries. It not only recognizes the keyword metadata for Apple Loops, but can also
categorize the contents of hundreds of CD-based loop libraries—even if no descriptive
information is embedded in those files.

Product Overview
Final Cut Pro 4

52

Soundtrack at a Glance
Soundtrack allows video editors to create high-quality, professional music that they
can quickly sync to their Final Cut Pro projects. Music loops can be combined and
arranged like building blocks to develop original, royalty-free music soundtracks. And
real-time control over every stage of production allows users to quickly evaluate
different options.
Designed from the video editor’s perspective, Soundtrack has a short learning curve.
By providing a music creation environment that’s familiar to Final Cut Pro 4 users, it
enables you to be creative and productive right from the start.
Video preview

Tempo and key

Markers

Loop searching

Timeline

Loop preview

Track controls
Powerful
automation

Video Import
Once your editing is near completion in Final Cut Pro, Soundtrack allows you to import
QuickTime movies in any resolution, from DV to HD, for creation of your original music
score. Soundtrack also retains scoring markers from Final Cut Pro 4.

Markers
Because Soundtrack supports Final Cut Pro 4 scoring markers, you can establish
important points in your video while editing in Final Cut Pro 4, then work with them
directly in Soundtrack while composing your score. In addition, you can set markers
at important video locations where you want musical rhythms or sound effects to
coincide with video events such as scene changes, action points, and so on.
Video edits that are requested after the music has been created can pose real problems in the traditional music editing workflow for video and film. Soundtrack offers
a flexible new solution by allowing editors to quickly resync their music to scoring
markers. Multiple tracks of audio can be instantly manipulated in real time to match
new editorial changes, without causing major setbacks to the project schedule.
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Browse
Soundtrack comes with thousands of audio loops for you to combine into original
music scores for your videos.
Powerful search tools
To save time while finding the perfect loops for your project, the Soundtrack Media
Manager comes with advanced search functions built to browse the 4000-plus bundled loops (the equivalent of eight to ten loop library CDs) or search through any of
the thousands of commercially available third-party Acid or AIFF/WAV loop libraries.
Other features of the Media Manager allow you to target your search of Apple Loops
and Acid libraries by identifying a mood (relaxed, intense, cheerful) or a genre (jazz,
electronic, cinematic, world) to find only the loops that meet the requirements of
your video project. Or, if you know you want to start with a particular instrument like
drums, guitar, or vocals, the powerful built-in search engine will find only the loops
meeting those requirements. With the ability to refine your searches even further by
using multiple criteria at once, you can quickly find the perfect music or sound effect
selection from the potential tens of thousands of loops available today.
Identifying suitable loops
While searching through your thousands of loops, you may find it useful to start
identifying those that work particularly well for your projects. Soundtrack allows
you to identify loops as favorites, making these loops quickly accessible for all your
projects. Soundtrack also has a standard file browser, allowing you to search your
loops in standard browser format.

Audition
You can listen to any loop as you browse through your potential choices while
listening to your score and watching your video in the Soundtrack video window.
The loops you audition are automatically adjusted to the tempo and key specified
for your project. You’ll quickly realize how easy it is to put the pieces together to
build your original score. Musical knowledge is not a prerequisite to creating great
scores with Soundtrack.
Without the need to worry about music theory, you can focus on the aesthetics of
your score from the perspective of your video. You can continue to audition more
loops, using the search feature to add piano to your guitar, then drums, an orchestra—
whatever suits you. Soundtrack lets you quickly search and audition more loops while
listening to the loops you have already arranged in the Timeline. All loops will play in
the same key and tempo, allowing you to make decisions for your video rather than
getting bogged down in details of audio engineering and music theory. You simply
drag new loops into the Timeline and build your soundtrack instrument by instrument. The only decisions you have to make when choosing loops are “Do I like it?”
and “Do I want to try something different?”
Project tempo
Often the pace of the music you want to add is too slow or too fast for the action
in your video. Speed up or slow down the session tempo, and your auditioning files
along with the loops in your project are played for you at the new tempo. You can
instantly change the tempo of your music to fit the pace and feel of your video.
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Project key
Finding loops that are in the right key for your project can be bothersome as well as
technically challenging—but not with Soundtrack. All music is automatically matched
to a project key for you, even if the music wasn’t originally played in the same pitch. If
you want to try different keys to see how they affect the mood of the music, you can
quickly adjust the project key, and all the loops will follow the new setting.
You can seamlessly blend all your audio loops and sound effects, regardless of key
or tempo. Soundtrack does it for you, enabling you to develop audio scores with just
the right mood and energy to add life and richness to video soundtracks.

Arrange
Once you find a loop you want to include in your new composition, drag it to the
familiar Timeline. You can drag the loop, split it, and repeat it quickly and easily
to fit with your video. Since Soundtrack immediately adjusts the audio loop tracks
to your project settings, you can experiment with different ideas during any stage
of the production. Your audio loops always remain matched as you adjust your
project parameters.
Marker snapping
Do you want an event to land on one of your markers? You can have the sound
snap right to the marker point.
Grid
Or maybe you want the loop to simply “groove” along in sync with the project.
Soundtrack gives you the ability to snap loops to various grid levels so arranging is
easy and fast.

Record
You can further customize your score by recording your own audio directly in
Soundtrack. Soundtrack allows recording from any Mac OS X Core Audio–supported
audio device.
Standard record
You can record while watching your video and listening to your score of arranged
loops. You can record and edit your own voiceovers right in Soundtrack, so you can
work with your music and voice mix at the same time.
Loop record
Soundtrack makes it easy to enhance your sound library if you’re ready to record a
live musician. You can perform and record your own instruments as loops and get
multiple attempts to capture the best performance. Loop record mode allows you
to cycle the same section of your project as many times as you like, with each take
captured for you to review so you can pick the best one. These performances can
be saved as specially tagged Apple Loops, so your recordings can match with other
loops in your current and future projects.
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Mix
Once you have the basis of your score arranged, you can begin refining the music
by adjusting the volume and stereo panning, adding effects, and automating key
parameters of the mix.
Effects
Soundtrack doesn’t stop with allowing you to combine loops and having them
seamlessly match tempo and key. It includes a powerful set of more than 30 plug-ins
from Apple and Emagic that allow you to sculpt your sound even more. Soundtrack
works with the industry-standard Mac OS X Audio Units plug-in format, so you can
add more third-party plug-ins if the need arises. You can adjust your effects with a
simplified set of plug-in effect parameters or use the plug-in’s custom interface to
tweak the sound of each loop in your composition. What’s more, Soundtrack allows
you to automate each plug-in parameter, giving you total control of your effects in
the Timeline.
Automation
Every mixing and effect parameter can be automated in real time, just like keyframes
in Final Cut Pro. Volume, pan, and effects can all be precisely controlled on individual
tracks or for the entire project.

Export
Once you are finished with your score, Soundtrack gives you three ways to export
your project at up to 24-bit/96kHz resolution.
Export mix
Export mix outputs your entire project as a stereo AIFF or WAV file with all parameter
and master automation captured. This file can be brought back into Final Cut Pro for
final output.
Export tracks
If you want to take your mix into another application for more work, you can export
your project as individual stereo AIFF or WAV audio tracks. This gives you an individual
file for each audio track. This feature is perfect if you want to retain individual tracks
in Final Cut Pro. You can also export your audio tracks to another multitrack audio
application such as Logic for additional post-production or surround sound mixing.
Export QuickTime
Soundtrack also lets you complete your entire project by exporting your video track
and score into a completed QuickTime file, perfect for posting on the web or delivering to a client for review.

Soundtrack Loop Utility
Soundtrack comes with the Soundtrack Loop Utility, allowing you to create your own
Apple Loops and assign all the descriptive information that Soundtrack uses to search
and identify files. While Soundtrack supports AIFF, WAV, and Acid loops, Apple Loops
provide the greatest flexibility and sound quality.

Product Overview
Final Cut Pro 4

Product Features

•
•
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•

Editing and Timeline
Edit at 23.976, true 24, 25, 29.97, or 30 fps
Source/record three-point editing model
Insert and overwrite with or without transitions
Replace, fit to fill, and superimpose edits
Edit overlay for drag-and-drop editing
Blade and Blade All tools for adding edits
Extend and split edits
Sync indicators in Timeline
Adjacent (through edit) indicators in Timeline
Dupe detection in Timeline
Keyframe graphs
Track targeting
Track locking
Auto Select tools
Timecode or frames in Timeline
Clip, sequence, scoring, chapter, and compression
markers
Marker export to DVD Studio Pro for chapter
and compression settings
Scoring marker export to Soundtrack
Clip and sequence marker export to LiveType
for titling
Waveform display in Timeline
Opacity overlays in Timeline
Audio level overlays in Timeline
Custom, independent track heights

•
•
•
•
•
•
•
•
•
•

Trimming
Ripple
Roll
Slip and slide
Lift and ripple delete
Asymmetric, multitrack trimming
Dynamic trimming
JKL trimming
Trim Edit window
Timeline trimming
Keyboard and numeric trimming

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Effects
• RT Extreme for scalable software-based, multistream real-time effects and NTSC/PAL monitor
output of real-time effects for DV and OfflineRT
• RT Extreme quality settings: low, medium, high.
Low setting provides maximum simultaneous realtime streams and effects; high setting provides fullresolution output for finishing directly to DV tape
• RT Extreme modes: safe and unlimited RT
• 8-bit, 10-bit, and HDR (32-bit floating-point)
rendering
• Time Remap tool
• Keyframe graphs and editing in Viewer or Timeline
• More than 200 transitions, effects, and filters
• Unlimited effects favorites
• Copy and paste motion and effect attributes
• Unlimited layers with support for nesting
• Bezier curves with movable motion paths
• Numeric control and keyframe capabilities for
precise animation and effects
• 2D and 3D titles with Boris Calligraphy
• Animated titles, lower thirds, and graphics
with LiveType
• Composite and transfer modes
• Import multilayered Photoshop files with layers
and alpha support
• Support for many third-party After Effects plug-ins
• FXScript and FXBuilder for designing custom filters
and effects

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Audio
Up to 24-channel audio output
Onscreen multitrack mixing console
Real-time fader automation
Variable keyframe thinning
Real-time audio filters and effects
Real-time audio filter adjustments during playback
Soundtrack music composition tool with thousands
of music loops and sound effects
OMF audio export
Subframe audio keyframing to 1/100th of a frame
Sampling at 8kHz to 48kHz and 8 to 24 bits
Audio level meters (per track)
Mac OS X Audio Units plug-in support
Pan controls
Mute and solo controls
Audio waveform display in Timeline

•
•
•
•

•
•
•
•
•
•
•
•
•
•
•
•
•
•

Logarithmic audio fades
Scrubbing with or without pitch shifting
More than 25 audio filters
Peak Express audio editing tool
Media management
Media management tools
Render file manager
Extensive search, sort, sift capabilities in Browser
Clip labels
Custom comment fields
Master and affiliate clips
Move, copy, transcode items at sequence or
project level
Consolidate, trim, or archive
Online with automatic reconnect and batch
capture capabilities
EDL I/O
Autosave Vault
XML interchange format for custom integration
Batch export
Compressor integration (see “Compressor” on
page 42 for details)

Color correction
Primary (three-way) color corrector
Secondary (two-way) color corrector
YUV
Image control filters
Four- and eight-point garbage mattes
Hardware-accurate waveform monitor and
vectorscopes
• Broadcast-safe filter
• Range-checking zebra strip overlays
•
•
•
•
•
•

Tools
• Multitrack audio mixer
• Keyboard and user interface customization tool
• Voice Over tool for adding narrations directly
to Timeline
• Frame Viewer for shot comparisons
• Source timecode overlays in Viewer and Canvas
• QuickView for RAM-based previews of complex
multilayered sequences

56

Product Overview
Final Cut Pro 4

•
•
•
•
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•
•
•
•
•
•
•
•
•
•
•
•

Application
Full Unicode support
Dynamic window resizing
Mode-free interface for workflow efficiency
Multiple sequences and projects open
simultaneously
Up to 99 levels of undo
99 audio and 99 video tracks with support for
nesting sequences together
Autosave Vault
System and user preferences
Easy Setups for quick configuration
Customizable keyboard
Customizable RT effects settings
Customizable render settings
Customizable window arrangements
Customizable user interface buttons
Customizable Browser layouts
Customizable track layouts
External editor support (helper applications)

Supported formats and I/O*
• Uncompressed 8- and 10-bit HD (4:2:2, YUV) via
PCI card
• Uncompressed 8- and 10-bit SD (4:2:2, YUV) via
FireWire or PCI card
• DVCPRO50 (4:2:2) via FireWire
• DV/DVCAM (4:1:1) via FireWire
• NTSC and PAL
• HD at 1080i and 1080p (23.976, true 24, 25, 29.97,
30 fps)
• Pull-down tools for telecine insertion and removal
(DVX100 and SDX900)
• Sample-accurate A/V synchronization
• Frame-accurate log and captures
• Serial device control (RS-422, RS-232)
• FireWire device control
• Log and capture tool with support for batch,
clip, and on-the-fly capturing
• Still images: PSD, BMP, JPEG, PICT, PNG, SGI,
TARGA, TIFF
• Insert and assemble editing to tape
• Compressor tool for batch export and encoding to
MPEG-2, MPEG-4, and other QuickTime formats

•
•
•
•
•
•
•

Cinema Tools
Support for 35mm 4-perf and 16mm-20
Comprehensive film management tool
24-fps EDL I/O
24-fps EDL conversion to and from 29.97 fps
Dupe detection in Timeline
Import ALE, ATN, FLX, and FTL files
Track key numbers, ink numbers, video and
audio timecode
Output the following lists:
– Cut list
– Change list
– Optical list
– Pull list
– Dupe list
– Missing elements list
– Audio EDL
Link media to database
Search and sort
Poster frame capability
Conform clips to specified frame rate
Reverse telecine function
Export ALE files
Import and export Final Cut Pro batch lists

•
•
•
•
•
•
•
•
•
•
•
•
•
•

LiveType
LiveFonts animated fonts
Customizable effects
Royalty-free animated content library
Sophisticated project templates
Keyframe animation
Real-time wireframe preview
Canvas RAM preview
Import wide variety of formats
Resolution independent and scalable
Dynamic individual character control
Unicode system font support
Animation for rolls and crawls
Type on a curve
FontMaker utility for creating custom LiveFonts

•
•
•
•
•
•
•
•

•
•
•
•
•
•
•
•

Soundtrack
Familiar interface for Final Cut Pro users
Modular design for managing audio loops
Import Final Cut Pro video with scoring markers
Several thousand royalty-free loops and
sound effects
Audio effects plug-ins from Apple and Emagic
Powerful search engine
Matching keys and tempos of combined loops
All work performed in real time
Support for AIFF, WAV, and Acid formats
Professional audio effects
Mac OS X Audio Units plug-in support
Fully automated mixing and effects

•
•
•
•
•
•
•
•
•
•
•
•
•

Compressor
High-performance encoding engine
Two-pass variable bit rate (VBR) encoding
Advanced motion estimation technology
Encode media directly from Timeline
Compatible I-frame insertion
QuickTime support
MPEG-4 support
Next-generation audio streaming media
Split-screen comparison
High-quality image processing
Many professional presets included
Automated encoding
Grouped presets for quick batch setup

•
•
•
•
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* Some features require additional hardware. Please contact
your Apple Authorized Reseller for information.
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Product Availability
and Support

Pricing and Availability
The estimated U.S. retail price of Final Cut Pro 4 is $999. Upgrades from Final Cut Pro
1, 2, or 3 are $399. Upgrades from Final Cut Express are $699. Contact your authorized
Apple representative for education pricing.
Final Cut Pro 4 is available worldwide in English. French, German, and Japanese localized versions will be available in August 2003. Final Cut Pro can be purchased from
the Apple Store (www.apple.com/store), through mail order, and at retail stores.

Final Cut Pro 4 System Requirements
• Macintosh computer with 350MHz PowerPC G4 processor and AGP graphics card
– RT Extreme requires a single 500MHz or faster PowerPC G4 (550MHz for
PowerBook G4) or any dual PowerPC G4.
– Soundtrack requires a single 500MHz or dual 450MHz or faster PowerPC G4.
• Mac OS X v10.2.5 or later
• QuickTime 6.1 or later
• 384 MB of RAM (512MB required for RT Extreme and recommended for Soundtrack)
• 1GB of disk space required for application installation
• 5GB of disk space required for Soundtrack content
• 9GB of disk space required for LiveType content
• DVD drive required for installation

Support
Final Cut Pro comes with 90 days of toll-free telephone support. In addition, Apple
offers a full range of professional support options, including AppleCare Professional
Video SupportLine, which provides a full year of affordable telephone access to Apple
multimedia technical experts. For details, visit www.apple.com/support/products.

For More Information
For more information about Final Cut Pro 4,
visit www.apple.com/finalcutpro.
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